
 

Institutional Effectiveness & Governance Council 
Meeting Minutes for May 25, 2023 

Time: 12:50 pm to 1:50 pm 
Zoom: https://rccd‐edu.zoom.us/j/83340733338?pwd=OEpuVkhPL0JXQ2FxYUw3VXprZkkxUT09 

Meeting Participants 

Council Members Present: 
Ms. Makenna Ashcraft, Ms. Caitlin Busso, Dr. Tenisha James, Ms. Ashlee Johnson, Ms. Ruth Leal, Mr. Dan Reade, Dr. Tim Russell, 
Mr. Alex Spencer, Ms. Leona Vassale and Ms. Dana White 

Council Members Not Present: 
Dr. Greg Aycock, Dr. Greg Ferrer and Dr. Mark Hartley 

Guest(s): 
Ms. Charise Allingham, Ms. Denise Terrazas 

Recorder: 
Ms. Desiree Wagner 

1. Call to Order 
• Time 12: 51PM 

2. Action Items 
2.1 Approval of Agenda (Mr. Dan Reade / Ms. Caitlin Busso) 

• Correction and retitle: Discussion Item 3.2: IEGC Prioritization Review Rubric 
• Approved by consensus. 

2.2 Approval of April 27, 2023, Meeting Minutes (Ms. Dana White / Mr. Alex Spencer ) 
• Approval of the March Minutes 
• Approved by consensus. 

2.3 Document Control Workgroup Proposal (Ms. Ashlee Johnson / Ms. Dana White) 
• Approved by consensus. 

2.4 Fall 2023 Meeting Calendar & Modality (Ms. Caitlin Busso / Mr. Dan Reade) 
2023‐ 2024 IEGC Meeting Schedule 
Every month on the Fourth Thursday, 12:50 pm to 1:50 pm in person location TBD 

• August 24, 2023* ‐ Vote if meeting will take place. (Approved by consensus to cancel) 
 September 28, 2023 
 October 26, 2023 
 November 16, 2023 (Date shift due to Thanksgiving) 
 February 22, 2024* ‐ Vote if meeting will take place. (Approved by consensus to cancel) 
 Mar 28, 2024 
 Apr 25, 2024 
 May 23, 2024 

 
2.5 DEIA Glossary of Terms (Ms. Dana White/ Ms. Ashley Johnson) 

• Ruth Motion to table this item for the Fall. DEIA has add this item to the June 6 meeting. (Second motion Leona) 
2.6 Marketing Committee Charter (Dr. Tim Russell/ Mr. Alex Spencer) 

• Ashley Motion to table this item for the Fall semester. (Second Dan) 
• *Dr. James Motion to extend the meeting (Ms. Leona Vassale/ Ms. Catilin Busso) (1‐ Opposed: Mr. Dan Reade) 



3. Discussion Items 
3.1 Assessment of the Evaluation Procedures & Governance Structure 

• Dr. James presented the findings. 
• Table to the fall meeting due to lack of time 

3.2 Draft Review of IEGC Leadership Council Report of Effectiveness 
• Table to the fall meeting due to lack of time 

4. Information Items 
4.1 Overview of IEGC’s Scope and Purview for Future Planning 

• The Co‐Chairs provided an overview of the Assessment of the Evaluation Procedures & Governance Structure 
process which occurs each od year in Spring according to the SPGM. Co‐Chairs began the initial assessment/audit 
and will discuss the findings with the Council at the next meeting. 

4.2 IEGC Faculty Co‐Chair 2023‐2024 Appointment 
• The Council was informed that, according to the SPGM, IEGC Co‐Chair terms will be complete at the end of Spring 

2023. Each constituent group retains full purview over their own appointment process. The council is asking that each 
group complete the appropriate process to elect/re‐elect an IEGC Co‐Chair for the Fall 2023‐Spring 2025 term and 
inform the Council of its selection. 

5. Good of the Order 

6. Future Agenda Topics 
6.1 Institution Set Standards 
6.2 Program Review Report of Effectiveness 
6.3 Norco Assessment Committee Report of Effectiveness 
6.4 Faculty Professional Development Committee Report of Effectiveness 

 
7. Adjournment: 

• Time 2:00 pm 

Next Meeting 
Date: September 28, 2023 
Time: 12:50 pm to 1:50 pm 

 
IEGC Purpose 

The Institutional Effectiveness & Governance Council (IEGC) coordinates, discusses, and makes recommendations regarding functions, plans, 
and activities related to mission, academic quality, institutional effectiveness, institutional integrity, leadership, and governance. The IEGC 
provides leadership and retains responsibility for ACCJC Standards I and IV, while serving as a communication link to the rest of the college 
regarding strategic and operational matters associated with their assigned Educational Master Plan objectives. The IEGC makes 
recommendations to the College Council, Academic Senate and the Vice President of Planning & Development. 



NORCO COLLEGE
DOCUMENT CONTROL SYSTEM

Presented by

Dr. Hayley Ashby, Professor Library, Accreditation Faculty Co-Chair
Dr. Tenisha James, Interim Vice President, Planning & Development



DOCUMENT CONTROL TEAM
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Lead:
Dr. Tenisha James, Interim Vice President, Planning & Development

Faculty: 
Dr. Hayley Ashby, Professor Library, Accreditation Co-Chair

Dr. Anthony Farmand, Associate Faculty

Classified Professionals:
Ms. Charise Allingham, Administrative Assistant III, Institutional Effectiveness

Ms. Desiree Wagner, Administrative Assistant IV, Planning and Development



WHAT IS THE PURPOSE OF DOCUMENT CONTROL 
SYSTEM? 
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To draft a document control system for 
Norco College which will improve accuracy 
and access to important documents. This 
system will be instrumental to maintain 
document integrity and traceability as we 
evolve and grow.



DOCUMENT CONTROL SYSTEM DEFINED
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 A document control system is a group of interrelated 
processes, workflows, and software products used in the 
production and management of documentation within an 
organization. A document control system (synonymously 
referred to as a document control process, document 
management system, document control, or document 
control procedure) sets the framework for how 
documents are approved, stored, updated or amended, 
how changes are tracked, how and where documents are 
published (internally or externally), and how documents 
are replaced, archived, and made obsolete.

 A document control system supports our efforts to 
advance our Educational Master Plan through increased 
efficiency in the organization of strategic and 
organizational documents to support continuous 
institutional improvement and alignment as outlined in 
our Strategic Planning and Governance Manual.



STRATEGIC ALIGNMENT
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1. EMP Objective 8:3 – Revise governance process –
formalize all unwritten governance processes for more 
effective implementation of the Educational Master 
Plan

2. The SPGM p.82, “Establish and maintain a Document 
Control System that includes a repository, establishes 
responsibilities, and ensures accurate organizing, 
routing and tracking of documents.”

3. EMP Core Commitment: Integrity – Maintaining an open, 
honest, and ethical environment.

4. Improvement Plan 2: Governance & Decision-making 
Making Processes & Procedures



RESEARCH & PROCESS
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 Discussed and documented existing document control practices and procedures

 Identified external laws, regulations, and requirements that impact document control 
practices (e.g., accreditation, FERPA, ADA, etc.)

 Determined the scope of the document control system (i.e., public v. confidential)

 Researched best practices from other educational institutions, organizations, 
associations, CA state resources, Library of Congress, National Archives, and ebooks

 Researched technology tools currently used within the District and investigated other 
possible solutions

 Developed a table of contents and drafted a Document Control Manual



DOCUMENT CONTROL SYSTEM
PART I 
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Introduction
 Purpose
 Definition
 Strategic Alignment

Document Inventory
 Scope of Inventory 
 Types of Documents
 Document Locations
 Document Inventory Form

Retention Scheduling
 Guidelines and Requirements
 Document Lifecycle and Stages
 Retention Schedules
 Retention Periods 



DOCUMENT CONTROL SYSTEM 
PART II 
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Document Management
 Storage and Organization 
 Naming Conventions
 Revision Procedures
 Automation
 Backup and Restoration 

Access Control
 Roles and Responsibilities
 Types of Access

Disposition of Documents
 Disposition Decision Workflow
 Archiving Documents
 Document Deletion

Appendix
 Acronym Abbreviation List & Glossary 
 Templates
 Training
 System Maintenance



QUESTIONS?

THANK YOU FROM THE 
DOCUMENT CONTROL PROJECT TEAM!

 DR. TENISHA JAMES
 DR. HAYLEY ASHBY
 DR. ANTHONY FARMAND
 CHARISE ALLINGHAM
 DESIREE WAGNER
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Introduction 

Norco College embarked on a two-year process in 2017 to develop the 2030 Educational Master 
Plan (EMP), which was Board approved in 2019. Our new strategic plan required rethinking our current 
participatory governance processes and procedures, which ultimately led to the creation of the Norco 
College Strategic Planning and Governance Manual (SPGM) adopted in the 2020-2021 academic year. 
Our commitment in developing an SPGM was to emphasize responsibility, transparency, collaboration, 
and inclusivity. Our structure includes a variety of operational groups and committees that report to our 
four Leadership Councils and Academic Senate, which submit approved recommendations to College 
Council and Executive Cabinet, ultimately, with final decision-making authority by the President, 
Chancellor, and Board of Trustees. Our four leadership councils include Academic Council, Institutional 
Effectiveness and Governance Council, Resources Council, and Student Support Council.  

The Institutional Effectiveness and Governance Leadership Council (IEGC) is charged with the 
coordination and recommendations for functions related to planning, mission, academic quality, 
institutional effectiveness and integrity, leadership and governance as outlined in the SPGM. As such, a 
critical role in the IEGC charge is to ensure that our governance structure is formalized to ensure 
responsibility and transparency. In the Spring of 2023, a workgroup of IEGC was formed to create a 
Document Control System to establish responsibility, support continuous improvement, and ensure 
accuracy of governance documentation, including the routing and tracking of documents. The proposed 
Document Control System aims to improve productivity within our participatory governance structure 
through improved documentation quality, compliance, and security to support our institutional 
effectiveness efforts.  
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Purpose  

To draft a document control system for Norco College which will improve accuracy and access to 
important documents. This system will be instrumental to maintain document integrity and traceability 
as we evolve and grow. 
Definition 

A document control system is a group of interrelated processes, workflows, and software 
products used in the production and management of documentation within an organization.  A 
document control system (synonymously referred to as a document control process, document 
management system, document control, or document control procedure) sets the framework for how 
documents are approved, stored, updated or amended, how changes are tracked, how and where 
documents are published (internally or externally), and how documents are replaced, archived, and 
made obsolete.   

A document control system supports our efforts to advance our Educational Master Plan 
through increased efficiency in the organization of strategic and organizational documents to support 
continuous institutional improvement and alignment as outlined in our Strategic Planning and 
Governance Manual.   
Strategic Alignment 

• EMP Objective 8:3 – Revise governance process – formalize all unwritten governance processes 
for more effective implementation of the Educational Master Plan 

• The SPGM p.82, “Establish and maintain a Document Control System that includes a repository, 
establishes responsibilities, and ensures accurate organizing, routing and tracking of 
documents.”  

• EMP Core Commitment: Integrity – Maintaining an open, honest, and ethical environment. 
• Improvement Plan 2: Governance & Decision-making Making Processes & Procedures  
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Document Inventory 
Scope of Inventory 

The documents in the College’s inventory are public documents in either printed or electronic 
form that fall into one of the following categories: 

• College/District Publications – Materials used to communicate with the public about college 
activities, instructional offerings, services, and resources. For Example, college catalogs, 
academic calendars, and brochures. 

• Strategic Planning Documents – Materials associated with strategic planning entities that 
are externally responsive and future oriented. For example, council meeting minutes, 
strategic plans, and accreditation reports. 

• Governance Documents – Materials connected to participatory governance groups 
concerned with addressing operational issues. For example, Academic Senate agendas, 
President’s Regular Updates, and department meeting minutes. 

Types of Documents 

Documents included in the inventory may be locally generated and apply specifically to the 
College or may be developed district wide and pertain to all RCCD colleges. 

These documents may include the following types of materials in a variety of file formats: 

• Plans 
• Reports 
• Processes 
• Charts 
• Fact Books 
• Scans 
• Agendas 
• Notes 

• Minutes 
• Charters 
• Presentations 
• Handbooks 
• Catalogs 
• Schedules 
• Calendars 
• Forms 

• Manuals 
• Guides 
• Brochures/Flyers 
• Newsletters 
• Proposals 
• Program Reviews 
• Syllabi 

Document Locations 

Documents within the scope of the inventory may reside in a physical or electronic location and 
may be housed locally in an office or on an individual computer or stored globally online or in an 
electronic repository. 

Possible locations include:  

• College website 
• District website 
• SharePoint 
• Teams 

• Email 
• Shared folders 
• Personal computers 
• Department/Area offices 

Document Inventory Form 

An efficient document management program relies on a regular assessment of what documents 
exist, where the documents are stored, how often the documents are updated, and how the documents 
are used.  
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Each department or area should periodically complete a document inventory form to provide 
specific details on the documents it creates, maintains, and stores.  

The information collected from inventory forms is used to establish and maintain a Document 
Retention Schedule that will ensure the overall accuracy, currency, and integrity of college materials.  

The Document Inventory Form requests the following information: 

• Date Inventory Prepared 
• Department/Area Maintaining the Documents 
• Person Responsible for Documents 
• Building and Room Number 
• Phone Number and/or Email 
• Document Title 
• Document Description 
• File Location 
• Media Type 
• Years Covered 
• Reference Status (Active, Semi-Active, or Inactive) 
• Remarks  

Example of Inventory Worksheet 

  

http://archives.cdn.sos.ca.gov/pdf/calrim-std070-records-inventory.pdf
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Retention Scheduling 
Retention scheduling is the process of determining the status or life of documents from initial 

creation to final disposition. Scheduling should take into consideration the purpose of the document 
and federal, state, and local regulatory requirements. 
Guidelines and Requirements 

Document control procedures must consider current regulations to ensure compliance with the 
law and external requirements. Best practices should also guide the creation and maintenance of 
documents for internal and public use.  

Accreditation 

Regional and programmatic accreditation requires that the College provide evidence that 
demonstrates the institution’s alignment with established standards. Accreditation evidence is 
consistent with the mission and may be used to demonstrate continuous improvement by documenting 
ongoing assessment, planning, and decision-making practices. 

Document control procedures including the consistent use of acronyms, file naming 
conventions, file organization, and archiving facilitate the discovery and utilization of evidence for 
accreditation purposes. 

Accreditation evidence may include: 

• Institutional fact books 
• Institutional environmental scans 
• Institutional reports 
• Institutional presentations 
• College catalogs 
• Planning documents 
• Program reviews 
• Faculty handbooks 
• Student handbooks 
• Meeting agendas 
• Meeting minutes 
• Survey results 
• Assessment results 

Americans with Disabilities Act (ADA) 

https://www.ada.gov/topics/intro-to-ada/ 

Create documents with accessibility in mind to ensure that your content can be read and 
understood by as wide an audience as possible. An accessible document is a document created to be as 
easily readable by a low-vision or non-sighted reader as a sighted reader. 

Well-designed, accessible files accelerate the distribution of information. Providing accessible 
electronic documents allows a greater variety of users to obtain information regardless of their 
individual needs. 

Word document accessibility: 

https://www.ada.gov/topics/intro-to-ada/
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https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-
disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d 

PDF accessibility:  

https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html 

Alt Text: 

Alt properties enable screen readers to read the information about images contained in digital 
documents. 

 

Family Educational Rights and Privacy Act (FERPA) 

The Family Educational Rights and Privacy Act (FERPA) is a federal law that affords parents the 
right to have access to their children’s education records, the right to seek to have the records 
amended, and the right to have some control over the disclosure of personally identifiable information 
from the education records. When a student turns 18 years old, or enters a postsecondary institution at 
any age, the rights under FERPA transfer from the parents to the student (“eligible student”). The FERPA 
statute is found at 20 U.S.C. § 1232g and the FERPA regulations are found at 34 CFR Part 99. 

Resources: 

i. Resources for Post-Secondary School Officials  

ii. FERPA 101: for Colleges and Universities  

iii. FERPA 201: Data Sharing under FERPA  

Personally Identifiable Information (PII) 

The U.S. Department of Labor defines PII as “Any representation of information that permits the 
identity of an individual to whom the information applies to be reasonably inferred by either direct or 
indirect means. Further, PII is defined as information: (i) that directly identifies an individual (e.g., name, 
address, social security number or other identifying number or code, telephone number, email address, 
etc.) or (ii) by which an agency intends to identify specific individuals in conjunction with other data 
elements, i.e., indirect identification. (These data elements may include a combination of gender, race, 
birth date, geographic indicator, and other descriptors). Additionally, information permitting the 
physical or online contacting of a specific individual is the same as personally identifiable information. 
This information can be maintained in either paper, electronic or other media.” 
(https://www.dol.gov/general/ppii#:~:text=Further%2C%20PII%20is%20defined%20as,with%20other%
20data%20elements%2C%20i.e.%2C) 

Personal Information as defined by RCCD:  

RCCD FERPA Information  

For more information and a list of Directory Information Please see RCCD Board Policy 3040 – 
Student Records, Directory Information and Privacy (https://www.rccd.edu/bot/Board_Policies/Chapter 
3 - Student Services/3040.pdf) 

Health Insurance Portability and Accountability Act (HIPAA) 

https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d
https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d
https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html
https://studentprivacy.ed.gov/audience/school-officials-post-secondary
https://studentprivacy.ed.gov/training/ferpa-101-colleges-universities
https://studentprivacy.ed.gov/training/ferpa-201-data-sharing-under-ferpa
https://www.dol.gov/general/ppii#:%7E:text=Further%2C%20PII%20is%20defined%20as,with%20other%20data%20elements%2C%20i.e.%2C
https://www.dol.gov/general/ppii%23:%7E:text=Further%2C%20PII%20is%20defined%20as,with%20other%20data%20elements%2C%20i.e.%2C
https://www.dol.gov/general/ppii%23:%7E:text=Further%2C%20PII%20is%20defined%20as,with%20other%20data%20elements%2C%20i.e.%2C
https://www.rccd.edu/Pages/FERPA.aspx
https://www.rccd.edu/bot/Board_Policies/Chapter%203%20-%20Student%20Services/3040.pdf
https://www.rccd.edu/bot/Board_Policies/Chapter%203%20-%20Student%20Services/3040.pdf
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The Health Insurance Portability and Accountability Act of 1996 (HIPAA) is a federal law that 
required the creation of national standards to protect sensitive patient health information from being 
disclosed without the patient's consent or knowledge. 

(https://aspe.hhs.gov/reports/health-insurance-portability-accountability-act-1996) 

Acronyms 
Use Abbreviations and Acronyms that the reader can quickly recognize.  
Be sure to spell out the word/words of an abbreviation/acronym when used in the body of the 

text the first time and put the acronym in parenthesis. Do not put the acronym in parenthesis if the 
acronym will not be used again in the document. 

Example: Accreditation Commission for Community and Junior Colleges (ACCJC) 
Link to the Acronym list 

Brand Guide  

(Insert -Why to refer to the Brand Guide) 

Typography 

• Century Gothic 
• Avenir 
• Monserrat 
• Raleway 
• Relation 

Link to Norco College Brand Guide (should sections be included in the Appendix?)  

  

https://aspe.hhs.gov/reports/health-insurance-portability-accountability-act-1996
https://www.norcocollege.edu/committees/mc/Documents/Supporting/Norco-College-Brand-Guide-20FAL-NC.pdf
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Document Lifecycle and Stages 

Document management involves the control of documents from initial development or receipt 
through final disposition.  

A document’s lifecycle refers to its movement through three stages, which define the 
document’s status. These stages are active, semi-active, and inactive. 

STAGE DEFINITION ACTIVITIES 
Active Support the College’s current governance and 

planning functions, processes, projects, and 
initiatives 

Creation, distribution, and 
use 

Semi-Active No longer used for current activities, but may 
be referenced and must be retained due to 
external requirements 

Digitize, store, and move 

Inactive No longer required for current activities and 
no longer needed for external requirements 

Archive or delete 

 

Retention Schedules 

Retention schedules are an essential component of a document control system as they identify 
the document to be managed and specifies how long it is to be retained. The retention schedule should 
consider the purpose of the document and its relevance to external requirements. 

A retention schedule provides instruction and guidance on how to maintain documents and is 
compiled and updated by a document controller. 

The benefits of establishing and implementing a document retention schedule: 
• Helps ensure compliance with external retention requirements for all documents 

regardless of format. 
• Identifies documents that may have privacy or security concerns. 
• Identifies who is responsible for maintaining documents to ensure the integrity of 

information. 
• Reduces storage of active documents to allow for the disposition of inactive, duplicate, or 

obsolete material. 
• Establishes a timeframe for documents to be transferred from active to inactive storage. 
• Provides direction for the deletion of records. 

The following steps guide the development of a document retention schedule: 

1. Plan and communicate – Identify roles and responsibilities and develop an action plan to 
create a retention schedule. 

2. Analyze college functions – Determine relevant college processes using strategic planning 
documents and organizational charts.  

3. Conduct a records inventory – Use the established inventory template to record 
information about institutional documents to be included in the repository. 

4. Document all internal and external requirements – Determine which documents meet 
college obligations and external compliance. 
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5. Determine retention periods – Use the records inventory and recommended retention 
timeframes for internal/external requirements to establish retention periods. 

6. Prepare draft retention schedules – Use the established retention schedule template to 
develop a retention schedule. 

7. Review, approve, distribute, and train – Broadly communicate the schedule, address 
feedback, and revise as necessary; provide training on how to implement the schedule at all 
levels. 

Document controllers should review the retention schedule annually. The schedule may remain 
in effect as long as the nature, content, and functional usefulness of the documents is the same.  

Document retention schedules should be updated under the following conditions: 

• Changes in the purpose of the document 
• Changes in internal/external requirements 
• Changes in the nature of the college function or process formalized in the document 
• Changes in the way the document is used by college employees to perform their work 
• Changes in the organization of the document or series of documents, including the 

aggregation (compiling content in separate documents) or disaggregation of content 
(separating content in one document) 

• Changes resulting from modifications to the protocols for the document control system 

Retention Periods 

The retention period refers to the length of time that a document is stored in the College’s 
repository based on its usefulness in support of operational functions, strategic planning, and external 
requirements. 

The following criteria determine the value of the document to the institution and should guide the 
retention period: 

• Operational – The usefulness of a document in reference to the regular functions and 
responsibilities of college business 

• Strategic – The usefulness of a document in supporting institutional planning and processes 
• Legal – The usefulness of a document in demonstrating compliance with laws, regulations, 

federal/state codes, contracts, grants, accreditation, and other external requirements 
• Research – The usefulness of a document in providing information for institutional research 

purposes 
• Historical – The current or future usefulness of a document in recording and preserving the 

history of the College 

The table below provides suggested retention periods based on retention criteria: 

RETENTION CRITERIA RETENTION RANGE 
Operational 1-5 years 
Strategic 5-10 years 
Legal 10 years 
Research 5-10 years 
Historical Indefinitely 
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 Document Management 

Storage and Organization 

Storage and organization are key components of effective document management.  To manage 
large volumes of documents efficiently, it is essential to have a well-organized system for storing and 
retrieving them.  This can involve creating a system of folders and subfolders, using consistent naming 
conventions, and establishing metadata standards for indexing and categorizing documents.  It is also 
important to consider factors such as security, accessibility, and scalability when developing a storage 
and organization system.  This can involve implementing security measures to protect sensitive 
documents, ensuring that documents can be accessed easily by authorized personnel, and ensuring that 
the system can accommodate growing volumes of data over time.  

By developing a well-organized system for document storage and retrieval, Norco College can 
improve efficiency, reduce errors, and enhance the overall quality of document management processes.  
By following these steps, Norco College can create an efficient and effective system for storing and 
organizing documents, enabling easy retrieval and use of important information when needed. 

It must be noted that Controlled, Personally Identifiable Information (PII) storage and 
organization is a critical aspect of any organization's data management strategy.  PII includes any 
information that can be used to identify an individual, such as their name, social security number, date 
of birth, or address.  It is essential to ensure that PII is stored securely and organized in a way that limits 
access to only authorized individuals.  This includes implementing security measures such as encryption, 
access controls, and regular monitoring and auditing of PII storage systems.  Effective organization of PII 
also involves establishing clear policies and procedures for the creation, handling, and retention of PII 
documents.  By implementing controlled PII storage and organization practices, Norco College can 
mitigate the risk of data breaches and protect the privacy of their employees and students. 

Effective storage and organization are critical components of document management. To ensure 
that documents can be easily accessed and utilized when needed, it is essential to establish a consistent 
and efficient system for storing and organizing documents. The following steps can be taken to 
complete storage and organization for document management: 

Choosing a storage solution: Determine the best storage option based on the needs of the 
organization.  Physical storage, such as file cabinets or boxes, may be suitable; however, the preferred 
solution is digital storage using cloud-based solutions such as shared-drive or on-premises servers. 

Develop a standardized naming convention: Create a consistent naming convention for documents 
to ensure that they are easily identifiable and searchable.  This can include the date, document type, 
and a unique identifier. 

Categorize documents: Group documents into logical categories based on their purpose or content.  
This can be done by creating folders or tags that make it easy to locate documents. 

Establish an indexing system: Create an index or table of contents that provides a quick reference 
guide to the location of documents within the storage system. 

Implement access controls: Establish policies and procedures to control access to documents to 
ensure that only authorized individuals can view or modify them.  This can include password 
protection, encryption, and user permissions. 
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Naming Conventions 

The use of a universal naming convention is important to ensure consistency, improve 
findability/ searchability and offer transparency. Overall, the use of a universal naming convention will 
keep Norco’s important documents organized.  

Best practices when naming a file: 

• Keep the file name short but meaningful (under 25 characters) 
• Include any unique identifiers, e.g., project title, committee acronym, source. 
• Ensure the purpose of the document is quickly and easily identifiable. 
• Be consistent. 
• Include only alphanumeric characters, avoid special characters and spaces 

o No spaces, periods, slashes, backslashes, underscores  
o Separate with dashes only. 
o Use camel case to distinguish words (using a capital when words are not separated by a 

space i.e. CollegeCatalog ) or Pascal case (all words start with a capital, no spaces) 
• Make use of consistent, relevant elements. 

o Use acronyms and abbreviations when able. 
• Add date to end of file name in one of the following formats: 

o YYMMDD  
o YYYY 
o YYYY-YY 
o YYSemester (YYSUM, YYFAL, YYWIN, YYSPR) 

• File Naming Convention structure 
o Source-ContentTitle-Date (Who-What-When)  

 Examples 
• NC-StrategicPlan2021-24 (Norco College Strategic Plan 2021-2024) 
• NC-CollegeCatalog2022 (Norco College Catalog 2022) 
• NAC-Minutes230308 (Norco Assessment Committee Minutes March 8, 

2023) 
• NC-FLEX-Agenda-22FAL (Norco College FLEX Agenda Fall 2022)  

Best Practices when naming a folder: 

• Be consistent. 
• Use concise wording. 
• Write out full names; avoid using acronyms. 
• Use subfolders to logically organize documents (e.g., document type, academic year). 

Revision Procedures 

See Archiving Documents for details on how to archive a document when revisions are made. 
 

Automation 

Automation can play a crucial role in improving the efficiency and effectiveness of document 
management.  To implement automation effectively, Norco College should consider the following steps: 
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Identify areas for automation: Determine which areas of document management could benefit from 
automation.  This could include document capture, indexing, storage, retrieval, and distribution. 

Evaluate automation solutions: Evaluate different automation solutions to determine which one best 
meets the needs of the organization.  Consider factors such as cost, ease of implementation, 
scalability, and integration with existing systems. 

Develop a roadmap: Develop a roadmap for implementing automation, taking into account the 
resources required, timelines, and dependencies on other projects or initiatives. 

Establish data standards: Establish data standards to ensure that automated processes produce 
consistent, high-quality data.  This can include defining metadata fields, file naming conventions, and 
data entry rules. 

Train staff: Train staff on how to use the automated systems effectively.  Provide guidance on how to 
enter data, use the system, and troubleshoot issues. 

Monitor and optimize: Monitor the automated systems regularly to ensure they are working as 
expected.  Optimize the systems as needed to improve performance and address any issues that arise. 

By implementing automation effectively, Norco College can streamline document management 
processes, reduce errors, and improve data quality.  This can ultimately lead to increased productivity, 
improved customer service, and reduced costs.  
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Backup and Restoration 

Effective backup and restoration are critical components of document management.  To ensure 
that important documents are protected from loss or corruption, it is essential to implement a backup 
and restoration plan that meets the needs of the organization. The following steps can be taken to 
implement backup and restoration for document management: 

Determine critical data: Identify the documents and data that are critical to the organization's 
operations and must be backed up regularly.  This can include records, contracts, and other important 
documents. 

Develop backup procedures: Develop procedures for backing up critical data.  This may involve 
selecting a backup technology, such as tape, disk, or cloud-based solutions, and determining backup 
frequency and retention policies. 

Test backup procedures: Test backup procedures regularly to ensure that backups are complete, and 
that data can be restored in the event of a disaster or data loss. 

Establish restoration procedures: Develop procedures for restoring data in the event of a data loss or 
corruption.  This may involve determining restoration priorities, such as restoring critical data first, and 
selecting a restoration technology, such as file-level restoration or disaster recovery. 

Test restoration procedures: Test restoration procedures regularly to ensure that data can be 
restored quickly and accurately in the event of a disaster or data loss. 

Maintain and update procedures: Maintain backup and restoration procedures regularly and update 
them as necessary to ensure that they remain current and effective. 

By following these steps, Norco College can establish an effective backup and restoration plan 
that protects critical data and ensures that important documents are available when needed. 

 
Access Control 
Roles and Responsibilities 

Keep in mind laws and regulations when creating documents for internal and public use.   

Roles 
A document controller oversees all controlled documents for the College, making sure everyone 

is on the same page when they need to be. The controller also creates, designs, and maintains the 
architecture for document processes and procedures and enforces the proper chain of action and 
document identification. The controller goes through all documents and makes edits, updates, and 
checks for accuracy. Once this process is complete, the controller approves the document and 
distributes it to the correct people ensuring proper labeling, numbering, and accessibility to employees. 
When needed, the controller archives and maintains a secure storage space for these documents. 

Examples of roles that may be designated as the document controller: 
o Co-chair 
o Administrative Assistant 
o Recorder 

Responsibilities  
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• Manage and maintain all controlled College documents. 
• Update documents, forms, and templates. 
• Manage and maintain document control process systems. 
• Take charge of all document identification, filing, and uploading to the college website. 
• Frequently conduct document audits confirming they are current and accurately reflect 

recorded evidence. 
• Ensure revised documents are accessible. 
• Assist with communication during external audits. 
• Conform to College and District enforced specifications and document control process and 

procedures. 
• Attend trainings on document processes to ensure correct handling of documents from the 

ground up. 
• Oversee document through its entire lifecycle (from creation to disposition). 
• Check and edit incoming documents and prepare for distribution. 
• Create document filing and organizing systems that are both effective and efficient. 
• Ensure proper organization and security of documents (paper and electronic). 
• Log document requests and help retrieve documents as needed for employees. 
• Make available, notify, and distribute documents to relevant recipients. 
• Confirm delivery of documents to proper personnel. 
• Collaborate and communicate with managers and project leaders. 

Document Control Structure (Examples) 

Document Control Structure for College Governance 

College 
President 

Administrator 

Co- Chair 

Classified Professional 

Co- Chair 

Faculty 

Co- Chair 

Student Document 
Controller 

Full Access to  

Documents 

Full Access to  

Documents 

Read Only Access to 
Documents 

Read Only Access to 
Documents 

Read Only Access to 
Documents 

Full Access to  

Documents 

 

Document Control Structure for Departments 

College 
President 

Administrator 

 

Classified Professional Faculty Student Document 
Controller 

Full Access to  

Documents 

Full Access to  

Documents 

Read Only Access to 
Documents 

Read Only Access to 
Documents 

Read Only Access to 
Documents 

Full Access to  

Documents 
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Types of Access 

 Full Access 
Full access permission has full authoring permissions and can do anything with the document 

that an author can do, including set expiration dates for content, prevent printing, and give permissions 
to users. 

Read Only Access 
Read-only helps prevent unintentional changes you make to the document from being saved. 

Read-Only mode does not allow you to make any changes to the document, preventing you from 
inadvertently saving changes. 
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Disposition Of Documents 
Disposition Decision Workflow 

See Retention Schedules and Retention Periods sections  

Archiving Documents 

Archiving Documents is the process in which static (fixed/unchanged) documents are stored 
until they need to be accessed in the future. The process of archiving documents is important for 
keeping a historical record and for evidence of continuous improvement for important review processes 
such as accreditation. 

Archive Norco College documents when new versions are created, and/or when a document is 
no longer required for current activities and no longer needed for external requirements (valid or used). 
See Retention Schedules.  

How to archive a document: 

1. Add ’Inactive’ to the beginning of the file name. 
a. Example: Inactive-NAC-Charter-2020-21 

Save the file as a PDF/A 
b. PDF/A is an ISO-standardized version of the Portable Document Format (PDF) 

Specialized for use in archiving and long-term preservation of electronic documents. 
PDF/A identifies a ‘profile’ for electronic documents that ensures the document can be 
reproduced exactly the same way using various software in years to come. PDF/A 
documents are 100% self-contained, all of the information necessary for displaying the 
document, in the same manner, is embedded in the file. 

Save to the Archive folder within the same folder structure as the original location.  
c. Example: Archive NAC Supporting Documents 

Document Deletion 

Deleting documents will permanently remove them from the document inventory. Take caution 
to not delete documents without checking the retention scheduling section for guidance on what 
documents need to be retained.  

See Retention Schedule for suggested document retention periods. Use the flowchart below to 
determine if a document should be deleted or archived.  
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Retention or Deletion Flowchart: 
 

 

 

 

 

 

 

 

 

 

 
 

  

Is the type of document identified on the retention 
schedule? 

YES, or unsure! 

NO 

Has a new version of the 
document been saved to the 
document library with only 

grammatical edits? The 
content has not been 

  

 

YES 
NO 

ARCHIVE 

Has the document ever been used to 
support the College’s governance 
and planning functions, processes, 
projects, initiatives, an internal or 

external requirement, or as a record 
of an event? 

NO 

Could the document 
be used for 

accreditation? 

NO 
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Appendix 
Acronym Abbreviation List 

College/District Departments, Committees, 
Programs and Processes 

AC – Academic Council  

ACE – Accelerated, Certificate and Employment 

ADT – Associate Degree for Transfer 

AHWL-Arts, Humanities and World Languages 

ALO – Accreditation Liaison Officer  

AOE – Area of Emphasis (Degree) 

AP-Administrative Procedures 

APC – Academic Planning Chairs 

A&R- Admissions and Records 

AS-Academic Senate 

ASCCC – Academic Senate of the California 

Community Colleges 

ASNC – Associated Students of Norco College 

ASRCCD – Associated Students of Riverside 

Community College District 

ASRCC - Associated Students of Riverside 

Community College 

ASMVC - Associated Students of Moreno Valley 

College 

BAM – Budget Allocation Model 

BEIT - Business, Engineering and Information 

Technology 

BIRT – Behavioral Intervention and Resource Team 

BOT – Board of Trustees 

BP – Board Policy 

BS – Basic Skills 

CAI – Common Assessment Initiative 

CARE – Cooperative Agencies Resources for 

Education 

CC – College Council 

CCCAA – California Community College Athletic 

Association 

CI – Completion Initiative  

CI-D – Course Identification Numbering System 

CJPC – Career and Job Placement Center 

CML – Communications, Media and Languages 

CNUSD – Corona Norco Unified School District 

COC – Circle of Change Leadership Conference  

COR – Course Outline of Record 

CPROS- Classified Professionals (staff) 

CSEA 535 - California School Employees Association 

Chapter 535 

CTA – California Teachers Association 

CTE – Career & Technical Education 

CWI – Center for Workforce Innovation 

DBAC – District Budget Advisory Council 

DCC – District Curriculum Committee 

DE - Distance Education 

DEIA – Diversity, Equity, Inclusion and Accessibility 

(Committee) 

DEMC – District Enrollment Management 

Committee 

DOI - Dean of Instruction 

DRC - Disability Resource Center 

DSP – District Strategic Plan 
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DSPC – District Strategic Planning Council 

EC – Education Code 

ECE – Early Childhood Education 

EOPS - Extended Opportunity Programs and 

Services 

EMP – Educational Master Plan 

FLEX - Flexible Calendar Program 

FMP – Facilities Master Plan 

FMTF – Function Map Task Force 

FYCP – Five Year Construction Plan 

FYSI – -Foster Youth Success Initiative 

FYSS – Foster Youth Support Services 

GELO – General Education Learning Outcome 

GC – Government Code 

GP – Guided Pathways 

GSA – Gender Sexuality Awareness Club 

HACU – Hispanic Association of Colleges and 

Universities 

HRER – Human Resources and Employee Relations 

HSCE- High School Concurrent Enrollment 

ICC – Inter-Club Council 

IDS – Instructional Department Specialist 

IE - Institutional Effectiveness 

IEAC – Inland Empire Athletic Conference 

IEGC – Institutional Effectiveness and Governance 

Council 

IEP – Institutional Effectiveness and Planning  

IGETC – Intersegmental General Education Transfer 

Curriculum 

IMC – Instructional Media Center 

INST- Instruction 

IOI – Improvement of Instruction 

IR – Institutional Research 

ISS – Institutional-Set Standards 

JFK/JFKMCHS – John F. Kennedy Middle College 

High School 

KPI – Key Performance Indicators 

LLRCAC – Library and Learning Resource Center 

Advisory Committee 

LGA – Local Goal Alignment 

LGBTQ+ - Lesbian, Bisexual, Gay, Transgender, 

Questioning 

LLRC – Library and Learning Resource Center 

LLRCC – Library and Learning Resource Center 

Committee 

LFM – Leading from the Middle 

LMP- Logistics Management Program 

LO – Learning Outcome 

LRC - Learning Resource Center 

MAP – Military Articulation Platform 

MC – Marketing Committee 

MLA – Management Leadership Association 

MMAP – Multiple Measures Assessment Project 

MVC – Moreno Valley College 

NAC-Norco Assessment Committee 

NAS (NCAS) – Norco College Academic Senate 

NC – Norco College 

OAC – Orientation, Assessment, Counseling 

OEC – Orange Empire Conference (Athletic 

Conference within which Norco College previously 
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competed) 

PAB – President’s Advisory Board 

PD - Professional Development  

PDC- Professional Development Center 

PDC – Faculty Professional Development 

Committee 

PLO – Program Learning Outcome 

RC – Resource Council 

RRO – Robert’s Rules of Order 

PR – Program Review 

PRC - Program Review Committee 

RCC – Riverside City College 

RCCD - Riverside Community College District 

RJT – Racial Justice Taskforce 

ROP – Regional Occupational Programs 

RR - Resource Request 

SA – Summer Advantage 

SBS - Social and Behavioral Sciences 

SE - Student Equity 

SEP – Student Educational Plan 

SFS – Student Financial Services 

SI – Supplemental Instruction 

SLO – Student Learning Outcome 

SP – Strategic Plan 

SPGM- Strategic Planning and Governance Manual 

SS – Student Services 

SSS – Student Support Services 

SSC – Student Support Council 

SSCCC – Student Senate for California Community 

Colleges 

SSS/SSS RISE-TRIO- Student Support Services/ 

Realizing Individual Success through Education  

SSSP – Student Success and Support Programs 

STEM – Science, Technology, Engineering and Math 

SWOT – Strengths, Weaknesses, Opportunities and 

Threats 

SWP – Strong Workforce Program 

TC – Technology Committee 

TLC – Teaching and Learning Committee 

TSS – Technology Support Services 

VFS – Vision for Success 

VPAA - Vice President, Academic Affairs 

VPBS - Vice President, Business Services 

VPPD – Vice President, Planning & Development  

VPSS - Vice President, Student Services 

Norco College Buildings 

ATEC – Applied Technology Building 

CACT – Center for Applied Competitive 

Technologies 

CRC - College Resource Center 

CSS – Center for Student Success 

HUM – Humanities 

IT – Industrial Technology 

LIB – Library 

LRC – Leaning Resource Center 

NOC or OC – Operations Center 

PDC – Professional Development Center 

SC - Soccer Complex 

SSV – Student Services 
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ST – Science and Technology 

STEM – Stem Center 

THTR – Theater 

VRC – Veteran’s Resource Center  

WEQ – West End Quad 
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Glossary of Terms 

AB 1725 Comprehensive California community college reform legislation passed in 1988 that covers 
community college mission, governance, finance, employment, accountability, staff diversity, and staff 
development. 

Abstention A member who declines to vote.  The abstention is not counted in anyway – it has no 
bearing on the outcome.  A member is required to abstain if they have a financial conflict of interest in 
the outcome of a vote. 

Academic Year Period of time schools use to measure a quantity of study. Academic year can vary from 
school to school and even from educational program to educational program at the same school, but 
generally refers to July 1 through June 30. 

Accreditation The review of the quality of higher education institutions and programs by an association 
comprised of institutional representatives. The Accrediting Commission for Community and Junior 
Colleges (ACCJC) of the Western Association of Schools and Colleges (WASC) accredits California’s 
community colleges. 

Academic Senate The Academic Senate represents the faculty in academic and professional matters. 
The Roles of College Constituencies section of the Strategic Planning and Governance Manual further 
describes the role of faculty. 

Ad Hoc Committee A committee created by a council or standing committee to address and make 
recommendations on a particular subject as needed and meets until a task is completed. The members 
need not be from a council or standing committee. 

Administration Synonymous with management, this term is used to describe one of our five 
constituency groups defined by duties/job descriptions.  

Adopted Budget Legislatively required that each District adopt a fiscal year budget by September 15th 
unless a statewide extension, as a result of a budget impasse, is enacted. 

Advisory Group A group that makes recommendations and/or provides key information and materials 
to a position, program, group, or operational unit. 

Allocation The division or distribution of resources according to a formula or plan. 

Agenda The schedule of the meeting.  The order of business, including reports of officers, committees, 
individual members, and action items.  

Amendments A minor change or addition designed to improve a text, plan, or piece of legislation. 

Brown Act (The Ralph M. Brown Act) The Ralph M. Brown Act (Gov. Code, § 549501 et seq., 
hereinafter “the Brown Act,” or “the Act”) governs meetings conducted by local legislative bodies, such 
as boards of supervisors, city councils and school district boards. The Act represents the Legislature’s 
determination of how the balance should be struck between public access to meetings of multi‐
member public bodies on the one hand and the need for confidential candor, debate, and information 
gathering on the other Budgeting and Accounting Manual (BAM) The BAM has the authority of 
regulation in accordance with Title 5 Section 59011 of the California Code of Regulations (CCR), is 
distributed as part of the Board of Governors' responsibility to define, establish, and maintain the 
budgeting and accounting structure and procedures for the California Community Colleges as defined 
in California Education Code (EC) Section 70901. 
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Cabinet An administrative body led by the President that meets regularly to address administrative 
tasks. Synonymous with Executive Cabinet. 

California Community College Chancellor's Office (CCCCO) The California Community Colleges is the 
largest higher education system in the nation. The system is comprised of 72 districts, 116 colleges and 
enrolls more than 2.9 million students. Community colleges provide basic skills education, workforce 
training and courses to prepare students to transfer to four‐year universities. Colleges also provide 
opportunities for personal enrichment and lifelong learning. The Chancellor's Office operates under the 
direction of the state chancellor who is guided by the Board of Governors. The Chancellor's Office is 
charged with providing leadership, advocacy and support of the California Community Colleges. 
Serving as the administrative branch of the California Community Colleges system, the Chancellor's 
Office is also responsible for allocating state funding to the colleges and districts. Located in 
Sacramento, the Chancellor's Office includes the offices of the chancellor and vice chancellors who 
oversee the work of ten major divisions. Website: www.cccco.edu. 

California School Employees Association (CSEA) Chapter 535 The exclusive collective bargaining 
representative of Classified Professionals in the classified service employees unit in the Riverside 
Community College District for matters on salaries, benefits, and working conditions as well as the 
appointing body of classified representatives on committees and governance groups.   

California Teachers Association/Faculty Association (CTA/FA) Selected by the faculty of the Riverside 
Community College District as its sole collective bargaining agent under the provisions of Senate Bill 
160, representing the faculty on salaries, fringe benefits, and working conditions, as well as the 
appointing body of faculty representatives on hiring and other decision making committees that 
directly affect faculty working conditions. 

CCCCO MIS Data Mart A database program maintained on the Chancellor’s Office website (Data Mart) 
that enables external users to query student and staff MIS data and generate aggregated reports by 
college, district or statewide. 

Census The date in a semester in which students’ enrollment is counted for funding purposes. The 
census date in primary terms (fall and spring) is based on 20% of the meeting pattern for courses 
scheduled less than 18 weeks. 

Center An off‐campus site administered by a parent college that offers programs leading to certificates 
or degrees that are conferred by the parent institution. Centers must be approved by both the CCCCO 
and ACCJC through a substantive change. 

Charter A written constitution or description of an organization's functions designed to communicate 
transparently the scope, duration, purpose, and deliverables of a particular strategic planning entity.  

Chief Executive Officer A term used to describe a multi‐college district chancellor or the 
superintendent/president of a single‐college district. 

Civility Formal politeness and courtesy in behavior or speech 

Classified Professional District employees in the classified employees service unit in job classifications 
listed in the CSEA Chapter 535 collective bargaining agreement, Article 1.A.. This term is used to 
describe one of our five constituency groups. Classified professionals is the agreed upon term at Norco 
College for the collective body referenced in Ed Code and policy as “staff” or “classified staff.”  

http://www.cccco.edu/
https://datamart.cccco.edu/datamart.aspx
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Co-Chair/Chair A person in charge of a meeting or organizational entity; often jointly with another co-
chair(s).  
Completion The action or process of finishing something. 

Committee: A group composed of a variety of individuals representing college constituent groups and 
has a charge that has been approved by a council or the college president 

Confidential Staff – A group of employees comprised of Executive Administrative Assistants to the 
Board of Trustees, Chancellor, Vice Chancellors, and College Presidents, as well as select Human 
Resources positions. Confidential employees that are part of the classified service and their 
employment is consistent with the provisions of classified employees. 

Consensus A general agreement reached without a formal vote. Everyone agrees.  No objection.  Also 
called “general consent” or “without objection.” 

Consultation The mechanism for system-wide shared governance through which the Chancellor 
confers on policy issues with institutional and interest group representatives prior to making his 
recommendations to the Board.  

Council A group of constituency representatives designated or selected to perform specific functions 
on behalf of the College with a defined scope/purview as documented within the SPGM and their 
individual charters. 

Course Outline of Record (COR) A Course Outline of Record defines the content, objectives, methods 
of instruction and evaluation, sample textbooks, and instructional materials for a course. CORs are filed 
with the California Community College State Chancellor’s Office. 

Demographic A particular sector of a population. 

Disciplines Curricular subject matter areas designated by the Board of Governors (relying on the work 
of the Academic Senate) and used in establishing minimum qualifications for faculty. 

Distance Education/Distance Learning Classes and other educational services offered via the Internet 
or other technological means of teaching/learning remotely.  

Dual Enrollment Program in which high school students earn college credit during high school hours or 
extended hours. College courses are offered on the high school campus or online.  Dual Enrollment 
courses are closed courses only offered to high school students. Dual Enrollment courses are Free to 
high school students. 

Education Code (EC) The body of law that regulates education. Other laws that affect colleges are 
found in the Government code, Public Contracts code, Penal Code and others. 

Effectiveness The degree to which something is successful in producing a desired result; success. 

Enrollment Management The term used to describe processes related to setting priorities for and 
continuing student enrollment. 

Equity The quality of being fair and impartial. 

Ex-officio Those members of board, council, or committee appointed by virtue of another position or 
expertise.  May be voting members or non-voting.  Must be specified in the appointment. 

Expenditures Payment of cash or cash equivalent for payroll, goods or services or a charge against 
available funds in settlement of an obligation.  
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Faculty The teaching employees of the college, or of one of its departments or divisions, viewed as a 
body. Classified by job descriptions, the faculty are one of the five constituencies of the college.  

Fiscal Year A 12-month period to which the annual operating budget applies and at the end of which a 
government determines its financial position and the results of its operations. For governmental 
agencies in the State of California, it is the period beginning July 1 and ending June 30. Some special 
projects or grants use a fiscal year beginning October 1 and ending September 30, which is consistent 
with the federal government’s fiscal year. 

Full‐Time Equivalent Faculty (FTEF) The total number of full‐ and part‐time faculty based on full 
teaching workload, not headcount.  1.0 FTEF = One faculty member teaching 100% or their contractual 
workload for a primary term (fall or spring). If the contractual full-time term workload is 15 lecture 
hours per week, an instructor teaching 5 three‐unit lecture classes would be = 1.0 FTEF. One lecture 
hour per week equals 1/15th (.6667 FTEF); three lecture hours per week equals 3/15ths (.2 FTEF).  The 
lab calculation varies based on the level of preparation and grading associated with the lab activity. 

Full‐Time Equivalent Students (FTES) A measurement used to convert part‐time and full‐time student 
contact hours into full‐time equivalent study load. One FTES represents 525 total student contact 
(class) hours. One FTES typically represents one student taking 15 units of coursework for two primary 
16.4 week terms (15*2*17.5=525)/525=1.0 FTES. FTES are the primary measure by which state 
apportionment funding (and base workload) is allocated to districts. 

RCCD operates on a compressed 16-week calendar, altering the calculation of FTES for a standard full-
length primary term course, using a value called the Term Length Multiplier (RCCD’s is 16.4):  
FTES = (Weekly Student Contact Hours) * (Term Length Multiplier) / 525. 
FTES = (Weekly Student Contact Hours) * 16.4 / 525 

Full‐Time Faculty Obligation (FON) The number of FTEF (full-time equivalent faculty) a district is 
required to maintain under the California Education Code requirements, which aims to achieve a full-
time to part-time faculty percentage ratio of 75/25. Districts that fail to maintain a minimum FON are 
assessed a penalty equivalent to the statewide cost of 1.0 FTEF for each FTEF short of the FON. 
General Education A required pattern of courses covering a breadth of subjects thought to be useful 
for all college students regardless of major. The RCCD general education courses are defined in the 
College Catalog.  

General Fund The fund used to account for the ordinary operations of the district. It is available for any 
legally authorized purpose not specified for payment by other funds. 

Germane Relevant to a subject under consideration 

Goals the object of a person's ambition or effort; an aim or desired result. 

Governance having authority to conduct the policy, actions, and affairs of a state, organization, or 
people. 

Headcount The actual number of students enrolled. This is also known as unduplicated enrollment.

Key Performance Indicator (KPI) A quantifiable measure identified with specific goals and objectives 
for the purpose of evaluating the college’s success. 

Learning Outcomes 

• Service Area Outcome (SAO) An assessment measure by campus units that do not provide direct 
instruction to students yet do provide services that influence student success in achieving 
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learning outcomes. SAOs align with SLOs and may be measured indirectly through unit-designed 
surveys, performance indicators, and other achievement-based measurement tools. 

• General Education Learning Outcome (GELO) Measurable outcomes of knowledge, skills, 
abilities students should master as a result of their overall college experience.  At Norco, 
GELOs are synonymous with Institutional Learning Outcomes (ILOs). 

• Program Learning Outcome (PLO) Measurable outcomes of knowledge, skills and abilities 
acquired by completing a series of courses associated with a specific degree, certificate or 
program. 

• Student Learning Outcome (SLO) Measurable outcomes of knowledge, skills and abilities 
acquired by completing a course, or other campus services. 

Majority At least one more than half.  If a vote results in a tie there is no majority and the proposal 
does not pass. 

Management – Synonymous with Administration (see above) 

Management Information System (MIS) Refers to computer‐based systems that manage student, 
fiscal and other information. The CCC MIS database is comprised of unit record student and employee 
data from all colleges in the system. 

Minutes The recorded (written, video, recorded) memorialization of action taken at a meeting.  Should 
include all action items motions and the results of every decision/vote.  Also members present, date, 
start time, end time. 

Methodology A system of methods used in a particular area of study or activity. 

Network A collaborative hub of individuals often representing different groups brought together to 
coordinate efforts, exchange information and facilitate calendar planning. 

Objectives A thing aimed at or sought; tactics intended to reach a larger goal 

Operational The routine functioning and activities of a department, unit, division, or individual 
employee. 

Operational Group: A unit, team, department, division, or cross-functional team collaborating to 
execute routine functioning in support of our strategic plans. Creating college-wide plans is strategic; 
carrying out and implementing the tactics thereto are operational. 

Overseeing To watch and manage a job or activity; having some degree of responsibility  

Participatory Governance The practice of involving faculty, classified professionals, students and 
administrators in policy discussions and institutional planning at the local and state levels.  

Pell Grant A federal financial aid program that provides funds to low‐income students to help pay their 
educational expenses. 

Planning Team A group that convene various employees year-round from multiple departments and 
disciplines to discuss tactical and operational plans for a specific event, objective, or initiative. 

Professional Development Refers to employees developing and improving their skills to better meet 
the needs of their job duties, to further their development, and to acquire new perspectives/abilities.  

Program A determination for program review and assessment purposes. An instructional program is 
any program of study that leads to a degree, transfer degree, or California Community College State 
Chancellor’s Office recognized certificate of achievement. A non-instructional program is any 
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offering/initiative with an on-going, clearly identified budget code, parameters, or defined scope. 

Program Review Program Review is a process for continual evaluation, self-study, and improvement to 
ensure that our students are well-prepared and well-served to assist them in successfully achieving 
their further academic, career, and professional endeavors. It is the central process at the college 
where each academic and support department identifies goals and resource needs for program 
improvement. 

Project Team A small, organized group of people who perform shared/individual tasks of a specifically 
defined charter/project/objectives. Synonymous with a workgroup, project teams focus on short-term 
projects (up to 1-year) targeting a specific metric, outcome, or issue. 

Staff This term is commonly used two ways. 1. A more general term referencing all employees and 
constituency groups of the Riverside Community College District including faculty, classified, 
confidential, and management positions. 2.As referenced in California Education Code and Board Policy 
referring to members of the classified employee group (locally referred to as classified professionals).  

Standing Committee A permanent committee of the Academic Senate intended to consider all matters 
pertaining to a designated subject that meets on a regular basis.  

Strategic Elating to the identification of long-term or overall aims and interests and the means of 
achieving them. 

Student a person who is studying at Norco College; the focus of our mission. 

Student Success The primary definition of student success is the completion of a course, degree, 
certificate, or program of study that leads to transfer or career success. 

Student Success and Support Programs (SSSP) A categorical program that enhances student access to 
the California Community Colleges and promotes and sustains the efforts of credit students to be 
successful in their educational endeavors. 

Success The accomplishment of an aim or purpose. Success in an academic course is a grade of D or 
higher.  

Task Force A constituency-represented group created to address a special college-wide subject/issue 
and meets until the subject/issue is resolved. 

Title 5 The section of the California Administrative Code that regulates community colleges. The Board 
of Governors adopts Title 5 regulations. 

Title IX The Education Amendments of 1972. Title IX protects people from discrimination based on sex 
in education programs or activities that receive Federal financial assistance. It states that: No person in 
the United States shall, on the basis of sex, be excluded from participation in, be denied the benefits 
of, or be subjected to discrimination under any education program or activity receiving Federal 
financial assistance. 
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Title V A federally funded grant program of the Higher Education Act (HEA). Created in 1998 to assist 
certain colleges and universities in improving the higher education of Hispanic students in the United 
States. 

Town Hall Open convening’s that allow college leadership to address everyone in the Norco College 
community for the purpose of conveying significant plans and/or getting input on issues impacting the 
college. 

Quorum minimum number of members required to conduct a meeting.  Any action taken without 
quorum is null and void. 
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Templates 
(List with links to templates on the website or direct link to webpage with current templates?) 
Suggested templates: 
Charter 
Report of Effectiveness 
Minutes 
Notes 
Agendas 
Regular reports 
 
Worksheets – Retention Schedule, Document Inventory 
 
Guides – Document Security Instructions from Types of Access 
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Read Only 

 

You can ensure no one else can edit a document by making it read-only. Open File > Info > 
Protect Document to view your security options. From the Protect Document menu, select Always 
Open Read-Only. Now just save the document, close it, then reopen it again. 

Word flashes a message that the author would like you to open this as read-only, unless you 
need to make changes. Click Yes to open the document in read-only mode. Of course, anyone can say 
no and open the document in edit mode. The goal is to make it easier for people to open the document 
as read-only to mitigate the chances of making unintended changes. 

To remove the read-only restriction, open the document in edit mode. Click the File menu, go to 
Info > Protect Document > Always Open Read-Only. 
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Password Encryption  

 

You can encrypt a document with a password by going to File > Info > Protect Document and 
choosing the Encrypt with Password option. Word will prompt you to create a password for the 
document. Be sure to use a complex but memorable password because there’s no way to retrieve or 
reset the code if you forget it.  

Now save the document, close it, and reopen it again and Word will prompt you (and anyone 
else) to enter a password to access the document. 

To remove the password, click the File menu, go to Info, and select Protect Document, then click 
Encrypt with Password. A pop-up window will appear where you can delete the obscured password, 
then click OK. Resave and close the document, and the next time you open it, you won't be asked for a 
password. 
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Restrict Format Editing  

 

You can limit the ways in which your document can be edited. Click File > Info > Protect 
Document and select Restrict Editing. Your document then displays a Restrict Editing pane on the right-
hand side of the document for formatting and editing restrictions. Here, you can give people permission 
to read your document, select what parts they can edit, and choose how they do it. 

Check the box next to “Limit formatting to a selection of styles” to prevent people from changing 
the formatting of your document. Click Settings to open a Formatting Restrictions pop-up window, 
which shows all style changes that are allowed by default. You can keep that as is, change it to the 
Recommended Minimum, or change it to None. If you're not sure which setting to pick, choose 
Recommended Minimum. 

You can also check any of the three options under Formatting to allow AutoFormat to override 
formatting restrictions, block the ability to switch themes or schemes, and block the ability to switch 
QuickStyle Sets. If you're not sure, leave these three settings unchecked. Click OK to close the 
Formatting Restrictions window. 
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Restrict Content Editing  

 

Under Editing Restrictions, check the box next to “Allow only this type of editing in the 
document” to set how readers can change content in the document. Click the drop-down menu 
underneath to choose between four options: 

• Tracked changes turns on Track Changes in the document and restricts all other types of 
editing.  

• Comments allows readers to insert comments in your document without making any 
modifications.  

• Filling in forms lets readers fill in forms you have created but not change the content of 
the forms.  

• No changes (Read only) puts your document in read-only mode so no changes can be 
made.  
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Editing Exceptions  

 

If you check the option for Comments or No changes (Read only), you can create exceptions for 
people to be able to edit certain parts of your document. In the Exceptions section, check the box for 
Everyone and select any parts of the document that you want to be editable. 
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Enforce Protection  

 

Once everything has been set, click “Yes, Start Enforcing Protection,” then type and retype a 
password and click OK. Save the document, close it, then reopen it to see the editing controls on the top 
ribbon have been grayed out. If you allowed editing in certain sections of the document, click in that 
area and the controls become accessible again. 

To turn off the protection, click the Review tab and click the Restrict Editing icon. Click the Stop 
Protection button at the bottom of the Restrict Editing pane, then enter the password and click OK. 
Uncheck the options for Formatting and Editing restrictions that appear on the pane. 
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Add Digital Signature  

 

To protect your document with a digital signature, open File > Info > Protect Document and 
select Add a Digital Signature. This tells people who read your document that you and no one else 
signed it, indicating that you were the last person to revise and save it. 

To create a digital signature, you'll need a signing certificate. The first time you do this, Word 
flashes a message asking if you want to set up a digital signature. Click Yes, and a Microsoft support 
page will pop up to help you find a digital ID. Try the links for the various providers to get a digital ID. 
Then, click the “Add or remove a digital signature in Office files” link. Scroll down the page to learn how 
to add a digital signature. 

After you have the digital ID, return to the Protect Document button and again click Add a Digital 
Signature. Fill out the necessary fields and click the Sign button. You may be asked to confirm the digital 
signature, then click OK. 

Your document is now digitally signed and made read-only. Word explains that the document 
has been signed and marked as final and that if anyone tampers with it, the signatures become invalid. 
Anyone who opens the document will see the notice of your digital signature. 
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Mark As Final  

 

Instead of using a digital signature, you can still mark the document as final in a more unofficial 
way. Open File > Info > Protect Document and choose Mark as Final. Word will inform you that the 
document is now final and will be saved. By marking a document as Final, you disable typing, editing, 
and proofing capabilities and a message will appear to any reader that the document has been finalized. 

When someone opens the document, they will see a message at the top of the screen informing 
them of the file’s status. However, a reader can still make changes to the document if they click the Edit 
Anyway button. When that button is clicked, they can then edit and re-save the document. 

The ultimate goal of this option is not to prevent anyone from editing the document but to tell 
readers that it is the recommended final version. If someone still wants to edit the document further, 
their actions will be recorded. When a document is marked as Final, then edited again, the original 
person who locked it is still shown as the author, while the other person will be saved as the one who 
last modified the document.  
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Training 

(Discuss the need for training to implement document control to ensure consistency and 
proficiency in performing the associated functions; training would be coordinated through Instructional 
Technology Specialist; training would also be coordinated with the provider of the technology solution 
adopted for document control purposes; in addition to in person trainings, instructional guides and 
videos will be posted to the website) 
System Maintenance 

(Insert draft here- Refers to the overall maintenance of the document control system in terms of 
ensuring that file/folder names follow conventions, files/folders are properly organized, and that 
guidelines and requirements are followed; annual audit conducted during the summer to maintain the 
integrity of the document control system by ensuring that conventions are followed and documents are 
up to date; who is the master document controller? Could we expand the part-time admin assistant 
position in the library to full-time and include the responsibilities for supporting training and overall 
maintenance of the document control system? This could be the master document controller.) 
  



Diversity, Equity, Inclusion, and Accessibility Glossary of 
Terms 
The purpose of the Diversity, Equity, Inclusion, and Accessibility (DEIA) Glossary of Terms 
is to serve as a reference guide of DEI terms that are critical to our shared understanding 
for the need to advance efforts to address systemic racism in our system. While the list of 
terms is not exhaustive, the glossary identifies key terms informed by the DEIA Workgroup 
to help individuals engage in meaningful conversations on equity. This glossary is a living 
document and will be updated on an annual basis to reflect the evolution of our 
understanding of diversity, equity, inclusion, and accessibility. 

DEIA TERMS 

Accessibility: The opportunity [for a person with a disability] to acquire the same 
information and materials, engage in the same interactions, and enjoy the same services 
as a person without a disability in an equally effective and equally integrated manner, 
with substantially equivalent ease of use. This includes the intentional design or redesign 
of technology, policies, products, services, and facilities that increase one's ability to use, 
access, and obtain the respective item.1 

Ally: Person in a dominant position of power actively working in solidarity with individuals 
that do not hold that same power or they do not share a social identity with to end 
oppressive systems and practices. In the context of racial justice, allyship often refers to 
White people working to end the systemic oppression of people of color.2 

Anti-Racist: Person who actively opposes racism and the unfair treatment of people who 
belong to other races. They recognize that all racial groups are equal (i.e., nothing 
inherently superior or inferior about specific racial groups) and that racist policies have 
caused racial inequities. They also understand that racism is pervasive and has been 
embedded into all societal structures. An anti-racist challenges the values, structures, 
policies, and behaviors that perpetuate systemic racism, and they are also willing to admit 
the times in which they have been racist. Persons are either anti-racist or racist. Persons that 
say they are ‘not a racist’ are in denial of the inequities and racial problems that exist.3 

1
 University of Pittsburgh, Office for Equity, Diversity, and Inclusion. (n.d.) Diversity, Equity, and Inclusion Glossary. 
https://www.diversity.pitt.edu/education/diversity-equity-and-inclusion-glossary.; U.S. Department of Education, 
Office for Civil Rights. 2013, February 28. Resolution Agreement: South Carolina Technical College System. 
https://www2.ed.gov/about/offices/list/ocr/docs/investigations/11116002-b.html 

2
 Patel, V.S. (2011). Moving toward an inclusive model of allyship for racial justice. . The Vermont Connection     32, 78-88.; Reason, 
R., Millar, E.A., & Scales, T.C. (2005). Toward a model of racial justice ally development. .Journal of College Student 
Development 46(5), 530-546. 

3
 Kendi, I.X. (2019). How to be an antiracist. One World 
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Anti-Racism: A powerful collection of antiracist policies that lead to racial equity and are 
substantiated by antiracist ideas. Practicing antiracism requires constantly identifying, 
challenging, and upending existing racist policies to replace them with antiracist policies 
that foster equity between racial groups.4 
 
Bias: Is an inclination, feeling, or opinion, especially one that is preconceived or 
unreasoned. Biases are unreasonably negative feelings, preferences, or opinions about a 
social group. It is grounded in stereotypes and prejudices.5 
 
Co-conspirators: Are people who are willing to put something on the line to use their 
privilege to disband systems of oppression. In contrast to allyship, co-conspirators do not 
just educate themselves about systemic injustice and racism, but like modern-day 
activists, they take personal risks to pursue meaningful action.6 
 
Color Blindness: Is a racial ideology that assumes the best way to end prejudice and 
discrimination is by treating individuals as equally as possible, without regard to race, 
culture, or ethnicity. This ideology is grounded in the belief that race-based differences do 
not matter and should not be considered for decisions, impressions, and behaviors. 
However, the term “colorblind” de-emphasizes, or ignores, race and ethnicity, a large part 
of one’s identity and lived experience. In doing so, it perpetuates existing racial inequities 
and denies systematic racism.7  
 
Color-Evasiveness: Is a racial ideology that describes the same concept as color-blindness 
where individuals reject or minimize the significance of race. Color-evasiveness, however, 
avoids describing people with disabilities as problematic or deficient by using blindness 
as a metaphor for ignorance.8 
 

 
4 Kendi, I.X. (2019). How to be an antiracist. One World. 
5
 Bias. (n.d.). American Psychological Association Dictionary. Retrieved September 3, 2020, from 
https://dictionary.apa.org/bias.; Friarman, S.E. (2016). Unconscious bias: when good intentions aren’t enough. 
Educational Leadership, 74(3), 10-15,; Moule, J. (2009). Understanding unconscious bias and unintentional racism. Phi 
Delta Kappan (January), 320-326. 

6
 Ally vs. co-conspirator: What it means to be an abolitionist teacher [Video]. (2020). C-SPAN. https://www.c- 
span.org/video/?c4844082/use-rclip-ally-vs-conspirator-means-abolitionist-teacher.; Stoltzfus, K. (2019). Abolitionist 
teaching in action: Q & a with Bettina L. Love. ASCD Education Update, 6(112). 

7
 Apfelbaum, E.P., Norton, M. I., & Sommers, S.R. (2012). Racial color blindness: Emergence, practice, and implications. 
Psychological Science, 2(13), 205-209.; Plaut, V.C., Thomas, K.M., & Goren, M.J. (2009). Is multiculturalism or color blindness 
better for minorities? Psychological Science, 2(04), 444-446. 

8
 Annamma, S.A., Jackson, D.D., & Morrison, D. (2017). Conceptualizing color-evasiveness: Using dis/ability critical race theory to 
expand a color-blind racial ideology in education and society. Race Ethnicity and Education, 20(2), 147-162. 

Covert Racism: A form of racial discrimination that is disguised and indirect, rather than 
public or obvious. Covert racism discriminates against individuals through often evasive or 
seemingly passive methods. Since racism is viewed as socially unacceptable by 

https://dictionary.apa.org/bias
https://www.c-span.org/video/?c4844082/user-clip-ally-vs-conspirator-means-abolitionist-teacher
https://www.c-span.org/video/?c4844082/user-clip-ally-vs-conspirator-means-abolitionist-teacher


mainstream society, people engage in covert racism in subtle ways, and therefore it may go 
unchallenged or unrecognized.9 

Culture: Is the values, beliefs, traditions, behavioral norms, linguistic expression, 
knowledge, memories, and collective identities that are shared by a group of people and 
give meaning to their social environments. Culture is learned and inherited behavior that 
distinguishes members of one group from another group. Culture is not static and can 
change over time.10 

Cultural Change: Refers to the stages of development or new patterns of culture that 
occur as a response to changing societal conditions. Within an organization, cultural 
change is a new method of operating and a reorientation to one’s role and responsibilities 
in the organization. Effective cultural change in an organization involves moving the 
organization toward a new vision or desired state. This change is influenced by many 
factors including effective leadership in all aspects of the change process, intentional 
alignment of structures, systems and policies with the new culture, ensuring staff and 
stakeholder participation, clear and frequent communication regarding the cultural 
change, obtaining feedback and evaluating progress, and managing any emotional 
response to the change.11 

Cultural Competence: Is the ability to honor and respect the beliefs, language, 
interpersonal styles and behaviors of those receiving and providing services. Individuals 
practicing cultural competency have knowledge of the intersectionality of social identities 
and the multiple axes of oppression that people from different racial, ethnic, and other 
minoritized groups face. Individuals striving to develop cultural competence recognize 
that it is a dynamic, on-going process that requires a long-term commitment to learning. 
In the context of education, cultural competence refers to the ability to successfully teach 
students who come from cultures other than one’s own. It entails developing personal 
and interpersonal awareness and sensitivities, learning specific bodies of cultural 
knowledge, and mastering a set of skills for effective cross-cultural teaching.12 

9
 Bonilla-Silva, E. (1997). Rethinking racism: Toward a structural interpretation. American Sociological Association, 
62(3),465-480.; Sniderman, P.M., Piazza, T., Tetlock P.E., & Kendrick A. (1991). The new racism. American Journal of Political 
Science, 35(2), 423-447. 
10

Abu-Lughod, L. (1991). Writing against culture. In R. G. Fox (Ed.)          Recapturing Anthropology: Working in the Present 
(pp. 137- 162). Santa Fe: School of American Research Press.; Culture(n. .d.) American Sociological Association. Retrieved 
September3, 2020, fromhttps://www.asanet.org/topics/culture. 

11
Gibson, D.E.& Barsade, S.G. (2003). Managing organizational culture change: The case of long-term care. Journal of Social 

Work in Long-Term Care, 2(1/2), 11-34.; Kanter, R.M., Stein, B.A., & Jick, T.D. (1992). The challenge of organizational change. 
The Free Press.; Wuthnow, R. (1992). Cultural change and sociological theory. In Haferkamp, 
H. & Smelser, N.J. (Eds.), Social change and modernity (pp. 256-277). University of California Press.
Denboba, D. (1993) . MCHB/DSCSHCN Guidance for Competitive Applications, Maternal, and Child Health
Improvement Projects for Children with Special Health Care Needs      . U.S. Department of Health and Human
Services, Health Services and Resources Administration.; Moule, J. (2012) Cultural competence: A primer for
educators. Wadsworth Cengage Learning.; Rothman, J.C. (2008). Cultural competence in process and practice:
Building bridges. Pearson.
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Cultural Fluency: Is the ability to effectively interact with people from different cultures, 
racial, and ethnic groups. It includes an awareness of how to properly respond to 
differences in communication and conflict as well as the appropriate application of 
respect, empathy, flexibility, patience, interests, curiosity, openness, the willingness to 
suspend judgement, tolerance for ambiguity, and sense of humor.13 
 
Deficit-Minded Language: Is language that blames students for their inequitable 
outcomes instead of examining the systemic factors that contribute to their challenges. It 
labels students as inadequate by focusing on qualities or knowledge they lack, such as the 
cognitive abilities and motivation needed to succeed in college, or shortcomings socially 
linked to the student, such as cultural deprivation, inadequate socialization, or family 
deficits or dysfunctions. This language emphasizes “fixing” these problems and 
inadequacies in students. Examples of this type of language include at-risk or high-need, 
underprepared or disadvantaged, non-traditional or untraditional, underprivileged, 
learning styles, and achievement gap.14 
 
Discrimination: The unequal treatment of members of various groups based on race, 
ethnicity, gender, social class, sexual orientation, physical ability, religion, national origin, 
age, physical/mental abilities and other categories that may result in disadvantages and 
differences in provision of goods, services or opportunities.15 
 
Diversity: The myriad of ways in which people differ, including the psychological, physical, 
cognitive, and social differences that occur among all individuals, such as race, ethnicity, 
nationality, socioeconomic status, religion, economic class, education, age, gender, 
sexual orientation, marital status, mental and physical ability, and learning styles. 
Diversity is all inclusive and supportive of the proposition that everyone and every group 
should be valued. It is about understanding these differences and moving beyond simple 
tolerance to embracing and celebrating the rich dimensions of our differences.16 
 

 
13

 Inoue, Y. (2007). Cultural fluency as a guide to effective intercultural communication: The case of Japan and the U.S. 
Journal of Intercultural Communication, (15). 
14

 Center for Urban Education. (2017). Equity in hiring: Job announcements. University of Southern California Rossier 
School of Education.; Smit, R. (2012). Toward a clearer understanding of student disadvantage in higher education: 
Problematizing deficit thinking. Higher Education Research and Development, 31(2), 369-380.; Valencia, R.R.(Ed.). 
(1997). The evolution of deficit thinking: Educational thought and practice. Routledge Falmer 

15
 Department of Epidemiology. (2017). Equity, Diversity, and Inclusion Committee. University of Washington School of 
Public Health. Retrieved August 5, 2020, from 
https://epi.washington.edu/sites/default/files/DEI%20Glossary%20Word.pdf 

16
 Department of Epidemiology. (2017). Equity, Diversity, and Inclusion Committee . University of Washington School of 
Public Health. Retrieved August 5, 2020, from 
https://epi.washington.edu/sites/default/files/DEI%20Glossary%20Word.pdf 

Equality: The condition under which every individual is treated in the same way, and is 
granted the same access, rights, and responsibilities, regardless of their individual 
differences. People who support equality believe that different circumstances and 
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identities should not prescribe social disadvantage; therefore, equality is the elimination 
of this disadvantage.17 
 
Equity: The condition under which individuals are provided the resources they need to 
have access to the same opportunities, as the general population. Equity accounts for 
systematic inequalities, meaning the distribution of resources provides more for those 
who need it most. Conversely equality indicates uniformity where everything is evenly 
distributed among people.18 
 
Educational Equity Gap: The condition where there is a significant and persistent disparity 
in educational attainment between different groups of students.19 
 
Equity-Minded: Is a schema that provides an alternative framework for understanding the 
causes of equity gaps in outcomes and the action needed to close them. Rather than 
attribute inequities in outcomes to student deficits, being equity-minded involves 
interpreting inequitable outcomes as a signal that practices are not working as intended. 
Inequities are eliminated through changes in institutional practices, policies, culture, and 
routines. Equity-mindedness encompasses being (1) race conscious, (2) institutionally 
focused, (3) evidence based, (4) systemically aware, and (5) action oriented.20 
 
Ethnicity: Is a category of people who identify as a social group on the basis of a shared 
culture, origins, social background, and traditions that are distinctive, maintained 
between generations, and lead to a sense of identity, common language or religious 
traditions.21 
 

 
17

 Department of Epidemiology. (2017). Equity, Diversity, and Inclusion Committee. University of Washington School of 
Public Health. Retrieved August 5,2020, from 
https://epi.washington.edu/sites/default/files/DEI%20Glossary%20Word.pdf; Mann, B. (2014).Equity and equality are 
not equal. The Education Trust. Retrieved September 3, 2020, from https://edtrust.org/the-equity-line/equity- 
and-equality-are-not-equal/.; Spicker, P. (2006). Liberty, equality, fraternity. Bristol University Press& Policy Press. 

18
 Equity. (n.d.). National Association of College and Employers. Retrieved August10, 2020, from 
https://www.naceweb.org/about-us/equity-definition/ .; Mann, B. (2014). Equity and equality are not equal. The 
Education Trust. Retrieved September 3, 2020, fromhttps:// edtrust.org/the-equity-line/equity-and-equality-are-not- 
equal/ 

19
 101: Equity gaps in higher education. (2019).Higher Learning Advocates. Retrieved August14, 2020, from 
https://higherlearningadvocates.org/resource/higher-ed-101/101-equity-gaps-in-higher-education/. 

20
 Malcolm-Piqueux, L. (2017). Taking equity-minded action to close equity gaps. Association of American Colleges & 
Universities.; Malcom-Piqueux, L., & Bensimon, E. M. (2017). Taking equity-minded action to close equity gaps. Peer 
Review, 19(2), 5 8. 

21
 Dein, S. (2006). Race, culture and ethnicity in minority research: A critical discussion. Journal of Cultural Diversity, 
13(2), 68 67.; Senior, P., & Bohpal, R. (1994). Ethnicity as a variable in epidemiological research .  B. ritish Medical 
Journal, 309, 327-328. 

Gender: Is separate from ‘sex,’ which is the biological classification of male or female 
based on physiological and biological features. Gender is socially constructed roles, 
behavior, activities, and attributes that society considers “appropriate” for men and 
women. A person’s gender may not necessarily correspond to their birth assigned sex or   

https://epi.washington.edu/sites/default/files/DEI%20Glossary%20Word.pdf
https://edtrust.org/the-equity-line/equity-and-equality-are-not-equal/
https://edtrust.org/the-equity-line/equity-and-equality-are-not-equal/
https://www.naceweb.org/about-us/equity-definition/
https://edtrust.org/the-equity-line/equity-and-equality-are-not-equal/
https://edtrust.org/the-equity-line/equity-and-equality-are-not-equal/
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be limited to the gender binary (woman/man).22 
 
Gender Identity: One’s internal sense of being a man, woman, both, in between, or 
outside of the gender binary which may or may not correspond with sex assigned at birth. 
Gender identity is internal and personally defined, it is not visible to others, which 
differentiates it from gender expression (i.e., how people display their gender to the world 
around them).23 
 
Implicit Bias: Bias that results from the tendency to process information based on 
unconscious associations and feelings, even when these are contrary to one’s conscious 
or declared beliefs.24  
 
Inclusion: Authentically bringing traditionally excluded individuals and/or groups into 
processes, activities, and decision/policy making in a way that shares power.25 
 
Intersectionality: The acknowledgement that within groups of people with a common 
identity, whether it be gender, sexuality, religion, race, or one of the many other defining 
aspects of identity, there exist intragroup differences. In other words, each individual 
experience social structure slightly differently because the intersection of their identities 
reflects an intersection of overlapping oppressions. Therefore, sweeping generalizations 
about the struggle or power of a particular social group fail to recognize that individuals 
in the group also belong to other social groups and may experience other forms of 
marginalization. Unfortunately, institutions and social movements based on a commonly 
shared identity tend to disregard the presence of other marginalized identities within the 
group.26 
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 Torgrimson, B. N., & Minson, C. T. (2005). Sex and gender: What is the difference? Journal of Applied Physiology, 99 
(3),785-787. https://doi.org/10.1152/japplphysiol.00376.2005 

23
 Baum, J. & Westheimer, K. Sex? Sexual orientation? Gender identity? Gender expression? (2015). Teaching Tolerance. 
Retrieved August 14, 2020, fromhttps://www.tolerance.org/magazine/summer-2015/sex-sexual-orientation-gender- 
identity-gender-expression. 

24
 Harrison-Bernard, L. M., Augustus-Wallace, A. C., Souza-Smith, F. M., Tsien, F., Casey, G. P., & Gunaldo, T. P. (2020). 
Knowledge gains in a professional development workshop on diversity, equity, inclusion, and implicit bias in 
academia. Advances in Physiology Education, 44(3), 286 294. https://doi.org/10.1152/advan.00164.2019. 

25
 Gilson, C. B., Gushanas, C. M.L, i, Y., & Foster, K.(2020). Defining inclusion: Faculty and student attitudes regarding 
postsecondary education for students with intellectual and developmental disabilities. Intellectual & Developmental 
Disabilities, 58(1), 65 81. https://doi-org.ezproxy.losrios.edu/10.13521/ 934-9556-58.1.65 

26
 Subcultures and sociology intersectionality. (n.d.). Grinnell College. Retrieved August 14, 2020, from 
Https://Haenfler.Sites.Grinnell.Edu/Subcultura-lTheory-and-Theorists/Intersectionality/. 

Institutional Racism:  Particular and general instances of racial discrimination, inequality, 
exploitation, and domination in organizational or institutional contexts. While 
institutional racism can be overt (e.g., a firm with a formal policy of excluding applicants 
of a particular race), it is more often used to explain cases of disparate impact, where 
organizations or societies distribute more resources to one group than another without 
overtly racist intent (e.g., a firm with an informal policy of excluding applicants from a low 
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income, minority neighborhood due to its reputation for gangs). The rules, processes, and 
opportunity structures that enable such disparate impacts are what constitute 
institutional racism (and variants such as ‘structural racism,’ ‘systemic racism,’ etc.).27 
 
Low Income: Is defined per federal guidelines as household incomes that are or below 
100% of their poverty threshold. These households are considered “in poverty.” 
Household incomes that are below 50% of their poverty threshold are considered 
“severe” or “deep poverty.” Low-income persons have less disposable income than others 
and may sometimes struggle to cover their basic needs. In addition, low-income persons 
also face housing, food, transportation, and health disparities.28 
 
Marginalized/Marginalization: The process by which minority groups/cultures are 
excluded, ignored, or relegated to the outer edge of a group/society/community. A tactic 
used to devalue those that vary from the norm of the mainstream, sometimes to the point 
of denigrating them as deviant and regressive. Marginalized groups have restricted access 
to resources like education and healthcare for achieving their aims.29 
 
Merit: A concept that at face value appears to be a neutral measure of academic 
achievement and qualifications; however, merit is embedded in the ideology of Whiteness 
and upholds race-based structural inequality. Merit protects White privilege under the 
guise of standards (i.e., the use of standardized tests that are biased against racial 
minorities) and as highlighted by anti-affirmative action forces. Merit implies that White 
people are deemed better qualified and more worthy but are denied opportunities due to 
race-conscious policies. However, this understanding of merit and worthiness fails to 
recognize systemic oppression, racism, and generational privilege afforded to Whites.30 
 
Microaggressions: Are brief and commonplace daily verbal, behavioral and environmental 
indignities, whether intentional or unintentional, that communicate hostile, derogatory or 
negative racial slights and insults that potentially have harmful or unpleasant 
psychological impact on the target person or group.31 
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 Clair, M., & Denis, J.S. (2015). Sociology of racism. The International Encyclopedia of the Social and Behavioral 
Sciences, 19, 857-863. 

28
 Center for Poverty Research. (2017). How is poverty measured in the United States? The University of California at 
Davis, CA. Retrieved August 7, 2020, from https://poverty.ucdavis.edu/faq/how-poverty-measured-united-states. 

29
 Department of Epidemiology. (2017). Equity, Diversity, and Inclusion Committee. University of Washington School of 
Public Health. Retrieved August 5, 2020, from 
https://epi.washington.edu/sites/default/files/DEI%20Glossary%20Word.pdf.; Lassiter, C., Norasakkunkit, V., 
Shuman, B., & Toivonen, T. (2018). Diversity and resistance to change: Macro conditions for marginalization in post- 
industrial societies. Frontiers in Psychology, 9, 812. 

30
 Chang, R.S. (1999) .Disoriented: Asian Americans, law, and the nation-state. NYU Press.; Feagin, J.R., & Porter, A. 
(1995). Affirmative action and African Americans: Rhetoric and practice . Humboldt Journal of Social Relations, 21(2), 
81-103.; Harris, C.I. (1993). Whiteness as property. Harvard Law Review, 106(8), 1707-1791.; Jackson, R.L., & 
McDonald, A. (2019). The violence of white entitlement and the hypocrisy of earned merit. Departures in Critical 
Qualitative Research, 8(4), 64-68. 
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 Solorzano, D., Ceja, M., & Yosso, T. (2000). Critical race theory, racial microaggressions, and campus racial climate: 
The experiences of African American college students.  The Journal of Negro Education, 696, 0-73. 
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Minoritized: describes the process of “minoritization” whereby individuals are afforded 
less power and representation based on their social identities. These social identities, 
such as race and ethnicity, are socially constructed concepts that are created and 
accepted by society. They are used to minoritize individuals in specific environments and 
institutions that sustain an overrepresentation of Whiteness and subordinate other 
groups.32 
 
Obligation Gap: Is the call for civic consciousness and acts of genuine care with the 
intention of catalyzing change toward becoming a more equity-centered college through 
epistemological disruption and the reconstruction of educational structures and policies 
that negatively impact poor and ethno-racially minoritized students. It places the onus of 
change on the higher education institution rather than the student.33 
 
Oppression: The systemic and pervasive nature of social inequality woven throughout 
social institutions as well as embedded within individual consciousness. Oppression fuses 
institutional and systemic discrimination, personal bias, bigotry and social prejudice in a 
complex web of relationships and structures that saturate most aspects of life in our 
society. Oppression also signifies a hierarchical relationship in which dominant or 
privileged groups benefit, often in unconscious ways, from the disempowerment of 
subordinated or targeted groups.34 
 
Overt Racism: Is an unconcealed, unapologetic form of ethnocentrism and racial 
discrimination that is observable. Historically, overt racism is a creation and product of 
White supremacy. Characterized by blatant use of negative and/or intentionally harmful 
attitudes, ideas, or symbols and actions directed at a specific racial group or groups 
deemed nonwhite or colored, overt racism persists in many forms throughout 
contemporary society. Overt racism occurs in individual and group interactions, 
institutions, nations, and international relations, spanning micro- and macro-level social 
realities.35 
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 Benitez, M., Jr. (2010). Resituating culture centers within a social justice framework: Is there room for examining 
Whiteness? In L.D. Patton (Ed.), Culture centers in higher education: Perspectives on identity, theory, and practice. 
(pp. 119-134). Stylus.; Harper, S. (2012). Race without racism: How higher education researchers minimize racist 
institutional norms. The Review of Higher Education, 3(61), 9-29. 
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 Sims, J.J., Taylor-Mendoza, J., Hotep, L.O., Wallace, J., & Conaway, T. (2020). Minding the obligation gap in 
community colleges and beyond: Theory and practice in achieving educational equity. Peter Lang Publishing. 
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 Definitions of oppression, dehumanization and exploitation. (n.d.). Retrieved August 14, 2020, fromhttp://www - 
personal.umich.edu/~mdover/website/Oppression%20Compendium%20and%20Materials/Definitions%20of%20Opp 
ression.pdf. 
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 Elias, S. (2015). Racism, overt. In Smith, A.D., Hou, X., Stone, J., Dennis, R., & Rizova, P. (Eds.). The Wiley Encyclopedia 
of race, ethnicity, and nationalism. https://doi.org/ 10.1002/9781118663202.wberen398. 

Power: Is the ability to exercise one’s will over others. Power occurs when some  
individuals or groups wield a greater advantage over others, thereby allowing them 
greater access to and control over resources. There are six bases of power: reward power 
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(i.e., the ability to mediate rewards), coercive power (i.e., the ability to mediate 
punishments), legitimate power (i.e., based on the perception that the person or group in 
power has the right to make demands and expects others to comply), referent power (i.e., 
the perceived attractiveness and worthiness of the individual or group in power), expert 
power (i.e., the level of skill and knowledge held by the person or group in power) and 
informational power (i.e., the ability to control information). Wealth, Whiteness, 
citizenship, patriarchy, heterosexism, and education are a few key social mechanisms 
through which power operates.36 

Prejudice: A hostile attitude or feeling toward a person solely because he or she belongs 
to a group to which one has assigned objectionable qualities. Prejudice refers to a 
preconceived judgment, opinion or attitude directed toward certain people based on 
their membership in a particular group. It is a set of attitudes, which supports, causes, or 
justifies discrimination. Prejudice is a tendency to over categorize.37 

Privilege: Is unearned social power (set of advantages, entitlements, and benefits) 
accorded by the formal and informal institutions of society to the members of a dominant 
group (e.g., White/Caucasian people with respect to people of color, men with respect to 
women, heterosexuals with respect to homosexuals, adults with respect to children, and 
rich people with respect to poor people). Privilege tends to be invisible to those who 
possess it, because its absence (lack of privilege) is what calls attention to it.38 

Race: A social construct that artificially divides people into distinct groups based on 
characteristics such as physical appearance (particularly skin color), cultural affiliation, 
cultural history, ethnic classification, and the social, economic and political needs of a 
society at a given period of time. There are no distinctive genetic characteristics that truly 
distinguish between groups of people. Race presumes human worth and social status for 
the purpose of establishing and maintaining privilege and power. Race is independent of 
ethnicity.39 

36
Department of Epidemiology. (2017). Equity, Diversity, and Inclusion Committee. University of Washington School of 

Public Health. Retrieved August 5, 2020, from 
https://epi.washington.edu/sites/default/files/DEI%20Glossary%20Word.pdf; Raven, B.H. (2008). The bases of power 
and the power/interaction model of interpersonal influence. Analyses of Social Issues and Public Policy, 8(1) 1-22. doi: 
10.1111/j.1530-2415.2008.00159.x.; Weber, M.(1947). The theory of social and economic organization. Translated by 
A.M. Henderson and T. Parsons. New York: Oxford University Press.

37
Allport, G. W., Clark, K., & Pettigrew, T. (1954).  The nature of prejudice. Addison-Wesley.
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Racial Justice: The systematic fair treatment of people of all races, resulting in inequitable 
opportunities and outcomes for all. Racial justice – or racial equity – goes beyond “anti-
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racism.” It is not just the absence of discrimination and inequities, but also the presence 
of deliberate systems and supports to achieve and sustain racial equity through proactive 
and preventative measures.40  
 
Racism: Is the intentional or unintentional use of power to isolate, separate and exploit 
others on the basis of race. Racism refers to a variety of practices, beliefs, social relations, 
and phenomena that work to reproduce a racial hierarchy and social structure that yield 
superiority, power, and privilege for some, and discrimination and oppression for others. 
It can take several forms, including representational, ideological, discursive, 
interactional, institutional, structural, and systemic. Racism exists when ideas and 
assumptions about racial categories are used to justify and reproduce a racial hierarchy 
and racially structured society that unjustly limits access to resources, rights, and 
privileges on the basis of race.41 
 
Reverse Racism: A term created and used by White people to erroneously describe the 
discrimination they experience when racial minorities allegedly receive preferential 
treatment. Propagated by segregationist and those against affirmative action, reverse 
racism is a form of racism that denies the existence of White privilege and assumes that 
White people have a superior claim to the opportunities that racial minorities earn. This 
term is also generally used to describe hostile behavior or prejudice directed at White 
people.42 
 
Sex: Is the biological classification of male or female based on physiological and 
biological features. A person’s sex may differ from their gender identity.43 
 

 
40

 National Education Association. (2017). Racial Justice in Education. Retrieved August 05, 2020, from 
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Structural Racism: Is the normalization and legitimization of an array of dynamics 
historical, cultural, institutional and interpersonal that routinely advantage Whites while 
producing cumulative and chronic adverse outcomes for people of color. Structural 
racism encompasses the entire system of White domination, diffused and infused in all 
aspects of society including its history, culture, politics, economics and entire social 
fabric. Structural racism is more difficult to locate in a particular institution because it 
involves the reinforcing effects of multiple institutions and cultural norms, past and 
present, continually reproducing old and producing new forms of racism. Structural 

https://neaedjustice.org/wp-content/uploads/2018/11/Racial-Justice-in-Education.pdf
https://www.thoughtco.com/racism-definition-3026511
https://www.pacificu.edu/life-pacific/support-safety/office-equity-diversity-inclusion/glossary-terms
https://www.pacificu.edu/life-pacific/support-safety/office-equity-diversity-inclusion/glossary-terms
https://www.racialequitytools.org/resourcefiles/Definitions-of%20Racism.pdf
https://epi.washington.edu/sites/default/files/DEI%20Glossary%20Word.pdf


   
 
racism is the most profound and pervasive form of racism all other forms of racism 
emerge from structural racism.44 
 
Transgender: Is an umbrella term for people whose gender identity and/or gender 
expression differs from their assigned sex at birth (i.e., the sex listed on their birth 
certificates). Transgender people may or may not choose to alter their bodies through the 
use of hormones and/or gender affirmation surgery. Transgender people may identify 
with any sexual orientation, and their sexual orientation may or may not change before, 
during, or after transition. Use "transgender," not "transgendered.”45 
 
Underserved Students: Are students who have not been afforded the same educational 
opportunities and equitable resources as some of their peers or as other students in the 
academic pipeline. This group of students includes low-income, minoritized, disabled, 
and first-generation students.46 
 
White Immunity: Is a product of the historical development and contemporary 
manifestation of systematic racism and White supremacy. White immunity describes how 
White people are immune from disparate racial treatment and their privileges are 
elevated, while people of color are marginalized and denied their rights, justice, and 
equitable social treatment due to systematic racism. White immunity is used to engage 
and describe White privilege more accurately.47 
 
White Privilege: Refers to the unquestioned and unearned set of advantages, 
entitlements, benefits and choices bestowed on people solely because they are White. 
Generally White people who experience such privilege do so without being conscious of 
it.48 
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White Supremacy: Is a historically based, institutionally perpetuated system of 
exploitation and oppression of continents, nations and peoples of color by White peoples 
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and nations of the European continent; for the purpose of maintaining and defending a 
system of wealth, power and privilege.49 
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Charter for Marketing Committee 
Spring 2023 

This Charter is established between the Marketing Committee and the College to structure the 
process and planned outcomes included herein during the period of the 2023-2024 academic 
year.   

Purpose 
The Norco College Marketing Committee collaborates to build a consistent and recognizable 
brand for Norco College that is representative of the college and community that we serve.  

 

Charge 

The committee plays a key role in supporting efforts related to expanding college access by 
increasing both headcounts and FTES through marketing, branding, messaging, and campaign 
strategies in support of the college’s Educational Master Plan and Strategic Plan. The 
committee is integral to representing the image of the institution through the Norco College 
brand.  

 

Guiding Principles and Assumptions 

The Marketing Committee will provide marketing, campaign, and budget recommendations to 
, the College , the District Marketing & Communications Committee (DMCC) and the RCCD 
External Relations and Strategic Communications department.  

Decisions will be made utilizing available enrollment data, past campaign reports, social media 
metrics, advertising metrics, and other relevant student data. 

 

Scope & Expected Deliverables 
The committee supports the Educational Master Plan objectives 6.5 and 6.7.  

• Provide feedback/recommendations on college marketing priorities, goals, and 
objectives 

• Recommend updates to the NC Brand Guide and RCCD Brand Guide 
• Bring awareness to the NC Brand Guide 
• Develop marketing plan strategies and campaign recommendations to assist with FTES 

growth; provide feedback and recommendations on marketing campaigns 
• Provide recommendations for the marketing and advertising budget 
• Create Social Media guidelines based on district social media guidelines 



Scope & Expected Deliverables 
• Develop and provide resources, such as templates and messaging, to be made available 

on the Marketing Committee webpage. 

 

Membership 

The Marketing Committee will be comprised of ten members, inclusive of representatives of all 
constituency groups and assigned or appointed by their respective representative bodies. All 
members are voting members. 

• Faculty Representative (Co-Chair) 
•  CPROS Representative (Co-Chair) 
• Management Representative (Co-Chair) 
• CPROS Representative 
•  CPROS Representative 
• Faculty Representative 
• Faculty Representative 
• Management Representative 
• ASNC Representative  
• ASNC Representative 

The members of the Marketing Committee will act via email in between meetings for quick 
responses/feedback needed on marketing items with a short deadline. All NC Marketing 
Committee members will be part of these email communications. All communications will be 
conducted through the committee co-chairs. Any activity will be noted on the following 
meeting minutes. 

 

Meeting Time/Pattern 
The Marketing Committee currently meets monthly on the third Wednesday  via Zoom. In 
future, meetings may take place online, in person, or in a hybrid modality. Meetings are open to 
the college community and personnel from the Office of External Relations and Strategic 
Communications  are invited to attend with a standing agenda item. 

To request an item for a future agenda, please contact the Co-Chairs for consideration. 

 

Roles of Chairs and Members 
The Co-Chairs are accountable  to ensure continuity of dialogue between governance tiers. Co-
Chairs are responsible for preparing agenda and facilitating meetings of the Marketing 
Committee based on best practices and guidelines for effective facilitation. 

Members are recognized as stakeholders with important expertise and perspectives relevant to 
the strategic charge of the Marketing Committee that can help to achieve the committee’s 
charter deliverables. Members are expected to actively attend and participate in all meetings, 
deliberations, and decision-making processes of the Marketing Committee. While representing 
the perspectives of the constituency group to which they belong, members are expected to 



Roles of Chairs and Members 
engage in effective dialogue with committee peers with the intention of finding consensus on 
all issues that come before the committee. 

The Marketing Committee members will report meeting outcomes to their constituency 
groups. 

 

Meeting Procedures and Expectations 

The Co-Chairs, and members of this governance entity will adhere to meeting and governance 
best practices as follows: 

Meeting agendas are issued in advance of meeting times.  Meeting agendas are organized to 
achieve milestones established in the charter and prioritize actions pending, actions required, 
and problem solving to move the work of the group forward. Either minutes or notes are taken 
to record the groups progress OR a final summary report is to be submitted/posted.  

Members endeavor to: 

• Appropriately prepare for meetings based on the meeting agenda. 
• Arrive promptly and stay for the duration of entire meetings. 
• Participate in a problem-solving approach where the interests of all participants are 

considered in developing proposals and recommendations and, where appropriate, 
distinguish between constituency versus college-wide perspectives. 

• Welcome all ideas, interests and objectives that are within the scope of the charter. 
• Actively listen to engage in respectful and constructive dialogue. 
• Work with a spirit of cooperation and compromise leading to authentic 

collaboration. 
• Move forward once a consensus-based decision has been made. 
• Work collaboratively to move items forward as a group. Follow through on tasks that 

are committed to outside of scheduled meetings. 
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